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1 Introduction 
This document describes new and improved features in Dapresy Pro version 10. 

If you want to know more about these features, please contact Dapresy Global Support at: 

support@dapresy.com and they will be able to assist you. 

Best Regards, 

Dapresy Team 2016 

 

Email:  support@dapresy.com 

Telephone: + 46 (0)76 019 89 42 
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2 Overview 
The following improvements have been made in the Storyteller and the general administration pages. 

Storyteller 

 The object and context menu have been updated to support the new features 

 A new template library has been added that allows you to create your own templates out of 

single objects, groups of objects, slides, or reports. You can then reuse them in any other 

project. This will save lots of time during the setup of a project! You can also view and use 

professional template examples created by Dapresy. 

 A new object, “Dynamic Icon/Shape”, has been added. This makes creating infographic objects 

much easier.  

 New “multi-color” objects have been added to the Icon and Shape Library, which you can use for 

many things, like slide backgrounds. The Icon and Shape object can now also be defined as links 

to other slides, reports, external URLs, etc. Tooltips can also be defined to show additional 

information in popups. 

 Some minor chart updates have been made, like the new margin settings that let you control 

the layout better. 

 You can now bulk edit charts to quickly edit and alter your reports.  

 The Storyteller Tables have been improved so that the base size can be shown.  

 The Text object has been improved for better usability. The linking options have been improved, 

and tooltips can be added to show additional information.  

 A new setting for using/not using the thousand separator has been added to the Respondent 

data table and the Form report. 

Administration pages  

 The Answer block page has been replaced with a new page since the old one page contained 

Silverlight controls which are no longer supported by all browsers.  

  

http://www.dapresy.com/


 

www.dapresy.com  Technical Release Notes Dapresy Pro 10 Page 6 of 60 

 

3 Updated Object Menu, Context Menu and Border colors 
The Object menu has been updated to include the objects added to the Storyteller. The new menu is 

shown in the image below.  The main change is that there are 2 new options: “Template library” and 

“Dynamic icon/shape” (which you can read about in this document).  

Also, the slide options “Copy, Arrange, Delete and Import” have been grouped together into 1 button: 

Slide Options (seen below). 

The image below shows the new Object menu. 

 

The layout of the context menu (that appears when you right click) has also been updated, since more 

options have been added. The new layout is shown in the image below.  

The main change (aside from the new “Templates” option) is the “Size and Position” settings that are 

now shown in a cascade menu (see image below). 

The image below shows the new context menu and cascade menu. 
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When using the Positioning settings (highlighted in the image below). The menu now remains open 

when you click an option. This makes it very easy to center an object in the middle of the page by 

adjusting its height and width. 

The image below shows the context menu (with the Positioning options highlighted). The menu will 

remain open when these are used in order to reduce the number of clicks. 

 

 

 

Previously, the border of objects in the Storyteller were shown in blue, but to be more efficient, objects 

with a defined content will be shown in blue, and objects without a defined content will be shown in 

red. This means that a new inserted object is shown in red until it has been setup. The new logic makes 

it easy to identify which objects need to be worked on. The image below shows an example.  
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There are three objects shown in red - this means that no setup has been made to these objects yet. 
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4 Template Library 
A new Template Library has been added to make your report setup much more efficient. With the 

Template Library, you can save and store objects, groups of objects, slides, etc. to be reused in other 

projects! 

For a more effective setup, a wizard-like setup is used to apply questions, answers, filters, and time 

periods to the objects (coming from the library). This makes the report setup more user-friendly for non-

expert users. 

In The Template Library, you’ll find professional template examples provided by Dapresy that you can 

use in your projects. Use these templates for inspiration, use them as is, or customize them to match 

your company’s design!  

The following chapters describe: 

 How to insert a template into a report 

 How to fill the objects with data 

 How to create templates 

 How to arrange your Template Library. 

 

Note: All templates you create are shared between the Administrators within your own company. This 

means that the library is company specific, not Administrator specific. So feel free to collaborate! 

4.1 Insert Template to Your Report 

To open the Template Library, just click the “Templates Library” icon in the object menu (shown below). 

The library appears in a popup view as soon as the option is clicked.  

 

In the library, you’ll find your templates categorized in different folders. Within each folder, the 

templates are ordered alphabetically. To get information on a template, just hover over the template or 

enter preview mode. To access preview mode, just click the magnifying glass that appears when you 

hover over the template.  

The image below shows the Template library. 
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The image below shows the Preview mode. To move between different templates in the preview mode, 

just click the Next/Previous buttons or use the arrows on your keyboard. 

The image below shows the Preview window of the Template library. 

 

To insert a template into a report, either select the template and click ‘Import’ (as shown in image 1 

below) or double click on the desired thumbnail. You can also click ‘Import’ in the Preview mode (as 

shown in image 2 below).  

 

 

 

http://www.dapresy.com/


 

www.dapresy.com  Technical Release Notes Dapresy Pro 10 Page 11 of 60 

 

Image 1. The “Demographic” template is selected. Click ‘Import’, or double click the template thumbnail 

to insert the template into the report. 

 

Image 2. Click ‘Import’ from the Preview mode, and the template will be inserted into your report. 

 

As shown in the image below, each template is defined as an Object, Group, Slide, or Multiple slides. 

Note that if you insert a Slide or Multiple slide template, it will be inserted after the slide you are located 

in (e.g. If you are in slide 2 out of 4 in the report, then the new slide will be added as slide 3). If an 

Object(s) template is selected, then it is inserted into the slide you are located in. 
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When inserting an object (not a slide), you can decide if the object should be inserted in the original 

position or in the top left corner of the slide. The original position is the position where the object was 

located in when it was saved to the library.  

 

The ability to insert a template in a predefined position (the original position) is great when it comes to 

text objects, logos, headers, footers etc. that should always have a pixel precise position. 

The image below shows the setting for inserting the object(s). If the option is disabled, then the 

object(s) is inserted into the top left corner. If the option is enabled, then it is inserted into the original 

position.  

 

Note 1: Each object has a default setting that is defined when the template is being saved. Saving your 

templates to your desired settings will make it much easier to use the templates.  

 

Note 2: Once the template has been inserted into a report, there is no longer a connection between the 

inserted object and the Template Library. If a change is made in the Template Library, it does not affect 

the projects using the updated templates. 

 

 4.1.1 Search 

There is a “Search” feature in the Template Library so that you can easily find the templates you want. 

The search will analyze the folder you have selected as well as all subsequent child folders that follow. 

To search the entire library, select the top folder.  

This searches the Name and the Tags fields of the templates. The templates that match the search are 

shown in a single view, no matter what folder they are located in. 

 

The folders containing the templates that were found in the search will be highlighted. This will help you 

filter the results by selecting any of the highlighted folders.  
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4.2 Wizard - Setup of Template Objects  

 

Once the templates have been inserted into the report, then the question, answer, filter, and time 

period selections need to be made in objects like charts and tables. These settings are made in a user-

friendly wizard for a quick and easy setup.  

The image below shows the different wizard steps. In hierarchical filter projects, an extra step is added to 

define the hierarchical filtering settings as well. 

 

 

An object inserted from the library is 100% customizable, like the “ordinary” objects. So if you need to 

change any other settings than the ones shown in the wizard, just go to the “All Settings” tab and all of 

the settings can be changed. 

The image below shows the “All settings” tab. Enter this tab to view the ordinary object setup view. 
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Note: The Wizard is present in the objects that need to be connected to “question and answer” (Charts, 

Tables, Word cloud, Respondent Tables and Dynamic icons). The Wizard is not present in “static” objects 

(Text, Images, Icon and Shapes). The Cross table object does not support the Wizard setup either.  

 

4.3 Create and Edit Templates  

The following chapter describes how to create and edit a template.  

First, the Template concept needs to be described. There are four types of templates: 

 A single object – this can be an object of any type, like a text box, a chart, an image, etc. 

 A group of objects – multiple objects of any type that have been grouped together 

 A slide 

 A report (e.g. multiple slides) 

When a data object (like a chart or table) is saved into the Template Library, all settings are saved into 

the template (except for selected questions, answers, filters and hierarchical filter settings). Some 

settings that are variable dependent, like “sorting by value” in charts and tables, cannot be saved since 

these settings refer to the selected variables in the object. Settings which refer to other objects, such as 

“Sort on other chart” and “Links” in Text objects are not saved either.  

No settings are saved in the Cross table object when it is saved as a template. Instead, use the regular 

Table object if the purpose is to save it as a template. 

 

4.3.1 Save Template 

To save a report, slide, single object or group of objects as a template, just enter the context menu to 

find the save options (see image below). 
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The image below shows the options used to save a template. 

 

 

The options “Save slide as template” and “Save report as template” are always shown. The option “Save 

element as template” is only shown if a single object is selected. If a Group of objects are selected, then 

the option “Save group as template” will appear in the menu as well. 

Note: All settings in the report must be saved to the database properly before it can be saved as a 

template, so as soon as a change is made you need to “Save layout” to be able to save it to the Template 

library. 

If the option “Template” is disabled, like in the image below, you need to first save the layout of the 

report and then you can save into the Template library. 
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The image below shows an example where the “Template” option is disabled. To enable the “Template” 

option, click “Save layout.” 

 

Next, you need to select a folder to store the template in (a new folder can also be added if needed, see 

next chapter). You also need to enter a name for the template. The rest of the fields (Tags, Description 

and Good for) are optional.  

The image below shows the fields and settings to consider when saving a template. “Name” is the only 

mandatory field. The “Save as new” is disabled until a Template Name has been entered. 

 

As mentioned above, the Tags are used for searching, so we recommend you add tags to help find your 

templates easier. Description and Good for are used to enter details of the templates based on the 

different company needs. 
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www.dapresy.com  Technical Release Notes Dapresy Pro 10 Page 17 of 60 

 

The default setting for “Insert the object(s) in source position” is also set when the template is saved. 

This setting should be used when saving objects such as main headers, footers, logos, or any object that 

should be inserted in a specific position of the slide when used. 

Note: When the template is saved, the objects included in the template need to be processed on the 

server side in order to save all settings and create the thumbnail images of the template. This process 

can take a few minutes when saving a report with many slides. 

Tip: If you want to replace an existing template, simply select the template you wish to replace. The 

“Save as new” button will be replaced with an “Update existing” button. A confirmation message will 

appear when you click “Update existing” so that you’ll avoid overwriting existing templates by mistake. 

Note 2: You cannot save new templates or edited templates into the folder that contains Dapresy 

provided templates. You as an Administrator can only save (and edit) templates into the folder you or 

someone else in your company has created.  

Note 3: If you delete a parent folder, then all subfolders & templates will also be deleted. 

 

4.3.2 Edit Template 

In the Template Library, the templates details (Name, Tags, etc.) can be edited. A template itself can be 

moved to another folder or deleted. If you want to edit the objects themselves (the settings in the 

object such as chart type, interval, layout etc.), follow these steps: 

1. Insert the template into a report 

2. Edit the object in the report 

3. Save the template 

4. In save mode (in the template library) select the template you inserted in step 1 

5.  Select the option “Update existing” 

6. The template has been updated  

To update the Template details (Name, Tags, Description and Good for), first enter the Template Library. 

Then enter “Edit mode” by clicking the Pen icon that appears when you hover over the template (see 

the icon in the image below). Make the changes, then click “Update existing.” The changes will be saved. 
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To delete a template, click the Delete (trash can) icon shown when you mouse over. The icon is 

highlighted in the image below. 

Click the highlighted icon below to delete a template (a confirmation box appears to avoid deleting 

templates by mistake). 

 

To move a template to another folder, click the Move icon (highlighted in the image below). Select 

which folder you’d like to move the template to by clicking the connected Move icon in the tree.  
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Click the highlighted icon below to move a template to another folder. 

 

Select which folder to move to by clicking the corresponding Move icon 

 

Note: You can only move a template to the folders created by you or any other Administrator in your 

company. You cannot move a template to the folders containing templates provided by Dapresy. 

 

4.4 Create and Edit Folder 

The folders in the Template Library are used to categorize all of your templates. You can do this in many 

different ways. For instance, you can categorize by type of project, by type of object, by different use 

cases, etc. 

Before you build the folder structure, you should carefully think through your needs of a structure so 

that it will be easy to find the templates you’re looking for. You can always go back and edit a folder or 

move a template from one folder to another if needed.  

4.4.1 Creating a New Folder 

To create a new folder, first select the parent folder of the new folder (the new folder will be stored 

below the selected folder). Then click the option “New folder” and enter the name of the new folder in 

the input field that shows up. Then you’re done! 
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Note: You cannot create sub folder to the folder that contains Dapresy provided templates. You as an 

Administrator can only create sub folders to your company folders.  

 

4.4.2 Editing Folders 

Folders can be moved, renamed, sorted, and deleted. You can easily sort by dragging and dropping. The 

options to move, rename and delete will appear when a Folder is selected (as shown in the image 

below). 

The image below shows the edit options appearing when a folder is selected. 

 

Note: A folder can be moved into any folder, except into its own child folders. A folder cannot be moved 

into any of the folders that contain templates provided by Dapresy. When a folder is moved, all the child 

folders are automatically moved. All templates are moved as well. 

To sort the folders below a parent folder, simply drag and drop them. 
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5 Dynamic Icons  
A new object type named “Dynamic Icons” has been added to help you easily and efficiently create 

infographic objects. You can easily connect icons and shapes to variables, enabling them to do the 

following: 

 Partially fill in an icon based on results (see images below) 

 Change the color of an icon based on threshold values (i.e. is the KPI above or below the target?)  

 Show the difference between time periods using arrows with different rotations and colors  

 Replace a happy face with a sad face or replace a thumbs up with a thumbs down based on the 

difference between two values 

The images below show three typical examples of the first point listed above: the icons are partially 

colored based on the result.  

 

 

5.1 Setup  

The new Dynamic Icon object is located in the object menu under the “Data Objects” section (as shown 

in the image below). 

 

In general, the setup of the Dynamic Icon object is similar to the setup of charts and tables, since 

variables, filters, and time periods need to be selected.  
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In the end, the object generates one value which is compared to different “zones.” Each zone has its 

own defined icon and threshold values. The image below is a great example of a setup with two zones; 

one for showing a green thumb up if the result is 40% or higher, and another zone for showing a red 

thumb down if the result is less than 40%. 

 

The value that is being compared to the defined threshold value is either the actual value of the selected 

variable (e.g. the percentage or the mean value of a variable) or the difference between two items. The 

items that can be compared to each other are listed below; 

 Two questions (Example: The difference between the Performance variable and the Importance 

variable in a customer survey) 

 Two answers (Example: The difference between the brand of the customer vs the best 

competitor in a brand survey) 

 Two compare filters (Example: The difference between two different target groups) 

 Two time intervals (Example: The difference between two months) 

The next chapters describe how to setup a few different use cases. 

 

5.1.1 Partly fill an icon  

The image below shows a typical use case. The blue part of the icon represents the percentage value of 

all males in the survey. 
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To create an icon like above, follow these steps:  

Step 1: Select the Gender variable and the Male option, as shown in the image below. Also select “Single 

result” from the first dropdown list named “What to compare against threshold values” as the actual 

value that will be used to fill the icon. 

 

Step 2: If you need to select any filters or any specific time periods, you can select those in the tabs 

named Filters and Time. 

The image below shows the Filter tab. If any filters should be applied, these are selected in the same way 

as always. 
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Step 3: In the Icon tab, activate the option “Partly fill by value” (as shown in the image below).  

 

When this option is activated, you will need to define the Value color, Background color, Min/Max scale 

and Fill direction. The Min and Max scale settings are used to show right proportions. If the value that 

will be shown is a percentage value, then normally 0-100 is used. If the value is a mean value, then the 

Min and Max scale needs to be set to 1-5, 1-10 or whatever scale is used to show the result in the right 

proportions.  

The image below shows the setting used to partly fill an icon based on the result. 
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Step 4: Choose the icon that you would like to use by clicking the “Select” option highlighted in the 

image below. When clicking this option, the Icon and Shape Library appears, and you can select any icon 

or shape.   

In this use case, only one zone needs to be used since the same icon should be shown no matter what 

the result is. So the Start and the Stop value defining the range of each zone can be set to the min and 

max scale (0-100).  

 

After you’ve completed these 4 steps, you’ll need to click “Update preview” in the top right corner to 

preview the icon. The result shown below the icon (see the image below) is only shown in the setup 

mode and not in the report. Only the icon is shown in the report.   
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5.1.2 Color an Icon Based on Target Value  

The image below shows a typical use case based on a brand awareness question. The flag should be 

colored red if the value is below 40%, and colored green if the value is above 40%.  

 

To create an icon like this, follow these steps: 

Step 1: Select the variable that you would like to use. Select “Single result” from the first dropdown list 

named “What to compare against threshold values” as the actual result of the variable should be 

compared to the target value. 

 

Step 2: If you need to select any filters or any specific time periods, you can select those in the tabs 

named Filters and Time. 

Step 3: Create two different zones in the Icon tab: one for the red flag to be shown if the value is below 

40, and one for the green flag to be shown if the value is above 40.  
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The image below shows the setup of the two zones. The red flag is shown when the value is below 40 and 

a green flag if the value is above 40.  

 

After you’ve completed these 3 steps, you’ll need to click “Update preview” in the top right corner to 

preview the icon. The result shown below the icon (see the image below) is only shown in the setup 

mode and not in the report. Only the icon is shown in the report.   

The image below shows the result. The flag is colored red since the value is 30%, which is below 40%. 

 

Tip: You are free to select any icon in each zone. For example, you can use a happy/sad face (as shown in 

the first image below) or the same icon but with different rotation and color (as shown in the second 

image below). 
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The image below shows an example of different icons in each zone. 

 

The image below shows an example of two zones having the same icon but different color and rotation 

have been defined per zone. 

 

 

5.1.3 Change Icon Based on Comparison to Previous Month 

The image below shows a typical use case based on a comparison between 2 months. A green arrow is 

shown if the result is +2% units (or more) compared to a previous month, and a red arrow is shown if 

the result is 2% worse (or more) than previous month. A grey “no change” icon is shown if the change is 

between -2% to 2% units.  
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To create this icon, follow these steps: 

Step 1: Select the variable that you would like to use. Select “Difference between 2 intervals” from the 

first dropdown list named “What to compare against threshold values.” The difference between 2 

months should be compared to the threshold values to determine which icon (arrow) to show. 

 

Step 2: If you need to apply any filters, simply select them from the Filter tab. 

Step 3: In the Time period tab, select which intervals you would like to compare to each other (select 

between Days, Weeks, Months, Quarters, Half year, and Year). As shown in the image below, it is always 

the last 2 intervals that will be compared to each other. 
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Step 4: In the Icon tab, three different zones need to be created, as shown in the image below (one for 

each icon). 

The image below shows the settings. The red arrow indicates when the difference between the 2 months 

is -2% units or more, and the green arrow indicates when the difference is +2% units or more. The grey 

“no change” icon is used if there are no major changes. 

 

Once you’ve completed these 4 steps, you’ll need to click “Update preview” in the top right corner to 

preview the icon. The result (the difference) between the 2 months is shown below the icon. If the 

values should be compared the other way around, simply click “Change order.” 
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Note: The Dynamic icon object only supports one value. If Compare is used in the Optional Filters, then 

the selected Compare series will be treated as Filters only, and not Compare filters. E.g. This same logic 

is applied to Scatter charts, Bubble charts, Word clouds and Respondent Data tables. 
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6 Icons and Shapes Update 

6.1 New Icons  

Many new objects have been added to the Icons and Shapes Library. There are so many new objects, 

that there are now two new categories! These are slide backgrounds and banners. Also, new objects 

have been added to the Blocks category.  

Most of the new objects are “semi-transparent,” meaning that different parts of the icon have different 

opacities. This provides a multi-color effect (shown in the images below) though there is only one color 

assigned to the icon. The image below shows three different examples of a semi-transparent icon. The 

selected color is the darkest color in the top right corner. The other sections are the same color but with 

a higher opacity.  

The image below shows an example of one of the new semi-transparent icons in three different colors. 

 

 

The image below shows some typical example of background objects that have been added to the Icon 

and Shape Library. These backgrounds are also semi-transparent, so you can change the color of a 

background with a single click! 
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The image below shows an example of some of the new blocks added to the Icons and Shapes Library 

which also are semi-transparent. 
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Tip: A new ‘Full size’ setting has been added in the context menu. This appears when you select an Icon 

or Shape object. The Full size option is shown in the Size and Position menu (see image below). Use this 

option after inserting a slide background so that the height and width will automatically set to cover the 

whole slide! 

 

 

 

6.2 Link and Tooltip Support in Icon and Shape  

The Icon and Shape objects have been enhanced with new settings to show tooltips and/or define an 

icon/shape as a link. The state of the icon/shape can also be changed on “hover over,” e.g. the icon 

changes color, size or opacity when you hover your mouse over the object (see images below).  

These new settings allow you to create reports more efficiently by using links between slides and 

reports. 

The reports can also be made more user-friendly by adding additional information in tooltips. 

The image below shows an example of an icon defined as a link. The left icon shows the icon in its normal 

state, and the right image shows how it looks when hovered over. 
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Below is an example of a shape placed over a chart defined as a link. The shape is transparent until it is 

hovered over (right chart in the image below).  

 

 

 

6.2.1 Setup 

The setup of links, tooltips, etc. will be made in a new tab named ‘Events’ (see image below). 

The image below shows the new Event tab in the Icon and Shape object used for setting up links and 

tooltips. 
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In general, there are two types of settings that can be used. These vary depending on if you hover over 

or if you click.  

As shown in the image below, the ‘Click’ and ‘Hover’ are split into two different panels. Based on a 

“Click” action, you can create a link or show a tooltip. Based on a “Hover” you can change the style 

(color, opacity and padding) and/or add a tooltip.  

The image below shows the two panels that define the actions based on Click and/or Hover. 
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Usually, the Click and Hover actions are used together, like in the example below: a tooltip is shown on a 

hover, and the link is activated on a click.  

 

When defining a Link, you can link to any object in any Storyteller report that is in the same project, to 

an external web page, or you can define the link to go back to the previous page (same as “back” in the 

web browser). Lastly, you can create advanced flows that allow the user to navigate between different 

slides based on links, rather than using the ordinary slide navigation. 

 

The layout of the Tooltip can be defined with the styling options shown in the image below. You can also 

define the position of the tooltip with the first dropdown list shown in the image below. 
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The image below shows the tooltip styling options. 
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7 Text Object Updates 

7.1 Improved Link and Tooltip Support in Text Object   

The Text object has been improved in the same way as the Icon and Shape regarding Links, Tooltips and 

styles on hover over.  

These new settings make the reports more user-friendly by adding additional information in tooltips. It 

is also more obvious to the user that a Text object is a link if the layout changes when they hover over it 

(as shown in the image below). 

The image below shows an example of a Text object defined as link. The left text shows the text in its 

normal state, and the right image shows how it looks when hovered over. 

 

 

7.1.1 Setup 

The setup of links, tooltips and hover over style are the same as Icon and Shape objects. See details in 

chapter 2.4.1.  To enter the setup view, click the icon highlighted in the image below. 

The image below shows the button to click to enter the setup of link, tooltips, etc.  

 

7.2 Improved Usability – Transparent Background 

The background of the Text boxes is now transparent in the setup mode so that you can see light 

colored text. Previously, the background color was white, so lighter text colors did not show up in the 

setup. 

The image below shows the new behavior of the Text object in the setup mode. The background is 

transparent so that light colored text is visible. 
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8 Chart Updates 

8.1 Bulk Editing of Charts 

For making changes and maintaining the reports efficiently, you can now “bulk edit” charts instead of 

making changes in one chart at a time. For example, you can change the background color, the number 

of decimals, or the font in all charts in the project (or just some of the charts) with only a few clicks. This 

new feature will save you lots of time! 

Bulk editing supports updates of the most common settings, but settings that are object specific are not 

supported due to the nature of the feature. The list below shows examples of settings that can be bulk 

edited: 

 Chart selections: Chart type, series option (stacked, side by side, etc.), legend position, show 

values, number of decimals, etc. 

 Time Settings: Interval, time period, etc. 

 Axis and Texts: Units, y-axis text, x-axis text, scale settings, etc. 

 Chart Layout Settings: Font, text size, colors, boarders, shadows, etc.  

 Tooltip options 

 Weight variable 

Some object specific settings that cannot be bulk edited are the selected questions, answer and filters, 

and some special settings which are dependent on things like the questions or the axis/legend 

positioning, like Sorting, Mean value series, Percentile settings, and Benchmark settings.  

 

8.1.1 Setup 

To apply changes from one chart to other charts, you need to enter the bulk edit mode which can be 

found in the chart setup view (see the image below). 

The image below shows the link to click to entering the bulk editing mode. 

 

The bulk edit view consists of two tabs: Settings and Objects. In the Settings tab, you can select the 

settings to be applied to other charts, and in the Objects tab you can select the charts to be updated. 

You need to make selections in both these tabs before the bulk editing can be applied. 

 

http://www.dapresy.com/


 

www.dapresy.com  Technical Release Notes Dapresy Pro 10 Page 42 of 60 

 

Settings 

In the Settings tab, you select which settings to apply to other charts. The settings are divided into 

Filters, Settings, Analysis and Layout. Tick the checkboxes of the desired settings or use the “Select all” 

option. 

The image below shows the Settings tab in the bulk edit view. 

 

 

Objects 

In the Objects tab, you select which objects should be effected.  You either use the quick options “Apply 

to all chart in the project”, “Apply to all charts in the current report” or “Apply to all charts in the current 

report and sub reports” or you make a custom selection by selecting the option “Custom selection.” 

 The image below shows the Object tab in the bulk edit view. 
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Once you have made your selections in both the Settings tab and in the Objects tab, the button “Apply 

settings” in the lower right corner gets enabled. Click the button to continue. A confirmation message 

will appear and show you which settings and charts will be effected. To apply the changes, just click 

“Yes, apply settings.” 

The image below shows the confirmation message. The message shows which settings and charts will be 

effected. 
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8.1.2 Undo 

If the wrong settings were applied or if the wrong charts were selected, you can undo a bulk edit action. 

The Undo option can be found in the bulk edit mode by clicking the History link, as shown in the image 

below. 

The image below shows the History link to click to be able to undo of a bulk edit action.  

 

In the History popup, you can see the date and time of the last 15 bulk edit actions. Click the “Undo” 

option to go back to a previous version. 

The image below shows the Undo popup window. 

 

Note: If you have done any “manual” changes after the bulk edit action, these changes will also be 

undone.  
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8.2 New Margin Setting  

A new “Margin” setting has been added to the charts to help avoid cutting off labels that are too long. 

The margins can be adjusted in the top, bottom, left and right. 

The image below shows a typical example of adjusted margins. The left chart shows the standard 

settings where you can see the far left question label is cutoff. The right chart shows exactly the same 

chart, but the left margin has been increased to avoid cutting off the labels. 

 

 

8.2.1 Setup 

The margins are adjusted in the Layout tab in the bottom of the Chart background panel. The default 

settings are: 

 Top: 5 

 Bottom: 12 

 Left: 8  

 Right: 8 

The image below shows the new margin settings. 
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8.3 Support for Showing “+” Prefix 

A new setting has been added that lets you show positive values with a “+” as a prefix (negative values 

are always shown with a “-“ as a prefix in Dapresy Pro). 

The new setting is great to use when a chart shows a “difference” between two values that has been 

calculated in a computed variable or imported via the data file. In these situations, the system typically 

does not show the result with a “+” since the system does not recognize the result as a difference 

between two values. 

The example charts below display the difference between Sales and Budget that has been calculated in a 

Computed variable. In this case, it’s helpful to show a “+” as prefix. The top chart uses the new setting, 

and the bottom chart uses the old behavior.   
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The new setting is located in the Settings tab in the Axis and Text Panel, as shown in the image below. 

 

 

8.4 Improved Base in Mean Value Calculation 

When calculating a mean value result of a categorical question, an answer like “Don’t know” is usually 

excluded from the calculation (the setting to exclude an answer from the mean value calculation is 

made in the Answer block page). 

When excluding an answer from the calculation, these respondents are not included in the base size 

displayed in the chart or when determining if a result should be hidden or not due to a low base size. 

This has been updated so you can show a base size that also includes the respondents answering an 

excluded answer option, like “Don’t know.”  

This new option can be applied to:  

 The base size shown in the charts 

 The base size used for hiding a result due to low base 

 Warning due to low base 

Note: The calculation of a result is not effected. The new setting only effects the displayed base size and 

the base size used for hiding/warning due to low base size. The actual mean values are not changed with 

this new setting. 
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8.4.1 Setup 

The new base size options are shown in the regular selection lists to define if a base size should be 

shown or not. Since the new option can only be applied to mean value calculations of categorical 

questions, the new options are only shown when this calculation type is selected. Also, the new options 

are only shown if any answers in the project have been excluded from the mean value calculation. 

The image below shows the new options for the displayed base size. 

 

 

The image below shows the new options for hiding results due to low base size. 
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The image below shows the new options for warning for low base size. 
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9 Table Updates 

9.1 Support for Showing Base Size 

The Table object is now supporting the ability to display the base size. You can define if the weighted or 

unweighted base size should be displayed, and you define if it should be displayed in columns or rows. 

The image below shows a table with a base size column activated. The base size information is always 

displayed in italic text.  

 

 

9.1.1 Setup 

You can find the base size settings in the Settings tab in the Table panel (as shown in the image below). 

The image below shows the new controls for displaying the base size in tables. The Label, Position and 

Orientation controls appear when “Weighted Base” or “Non-weighted base” is selected in the Base size 

information dropdown list. The controls are not shown if “Base hidden” is selected. 
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In the setup, you define the following:  

 Should a weighted or unweighted base size be shown (this setting is only applicable if a 

weighted result is shown in the table)  

 The label of the base size  

 The position (should the base size be shown in rows or columns) 

o The orientation (the top or bottom row or the most left or the most right column) 

The ability to select between rows and column will give you more flexibility in situations where both 

rows and columns are nested. 

See below for a few different examples of tables showing the base size. 

The table below shows the base size in columns. In the top table, it is shown in the most left column, and 

in the bottom table it is shown in the most right column. 
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The two tables below show the same result, but in the top table the base size is shown in rows, and in the 

bottom table the base size is shown in columns. 

 

Note: The number of decimals is not adjustable; it is shown with the same precision as the result itself. 

Though a smart logic is used to trim 0s in the end of the base size value, e.g. if the result is shown with a 

three-digit precision and the base size is 623.000, it will be displayed as 623. This means that the base 

size always is shown whole numbers when an unweighted base size is used, even if the result is shown 

with one or more decimals. 

Tip: The base size settings are defined per series in the table. In situations where a table shows multiple 

questions and you know all these questions have the same base size, you can set up the table in two 

series to get a layout like in the image below. The base size appears once, not once per question (the 

first series shows the first question as well as the base size of that question. The second series shows the 

next 3 questions without the base size). 

The table below shows an example where the base size is only shown for the first series and not for the 

second. This table uses a % sign as a suffix. As shown, the suffix is not applied to the base size. The 

suffix/prefix settings are only applied to the result cells. 
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9.2 Support for Showing ”+” Prefix 

A new setting has been added which makes it possible to show positive values with a “+” as prefix 

(negative values are always shown with a “-“ as prefix in Dapresy Pro). 

The new setting is great to use when a table for example shows a “difference” between two values, 

where the difference has been calculated in a computed variable or imported via the data file as in 

those cases the normal system behavior is to not show the result with a “+” as the system does not 

recognize the results as a difference between two values. 

The example tables below shows a typical use case where the difference between Sales and Budget has 

been calculated in a Computed variable, it is useful to show a “+” as prefix in this case. The top table uses 

the new setting, and the bottom table does not use the new setting.  
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9.3 Improved Base in Mean Value Calculation 

When calculating a mean value result of a categorical question, an answer like “Don’t know” is usually 

excluded from the calculation (the setting to exclude an answer from the mean value calculation is 

made in the Answer block page). 

When excluding an answer from the calculation, these respondents are not included in the base size 

displayed in the chart or when determining if a result should be hidden or not due to a low base size. 

This has been updated so you can show a base size that also includes the respondents answering an 

excluded answer option, like “Don’t know.”  

This new option can be applied to:  

 The base size shown in the charts 

 The base size used for hiding a result due to low base 

 Warning due to low base 

Note: The calculation of a result is not effected. The new setting only effects the displayed base size and 

the base size used for hiding/warning due to low base size. The actual mean values are not changed with 

this new setting. 

 

9.3.1 Setup 

The new base size options are shown in the regular selection lists to define if a base size should be 

shown or not. Since the new option can only be applied to mean value calculations of categorical 

questions, the new options are only shown when this calculation type is selected. Also, the new options 

are only shown if any answers in the project have been excluded from the mean value calculation. 

The image below shows the new options for the displayed base size. 
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The image below shows the new options for hiding results due to low base size. 

 

The image below shows the new options for warning for low base size. 
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10 Respondent Data Table: Setting for Thousand Separator 
A new setting has been added to the respondent data table that supports thousand separators. Take a 

look at the income column below to see numbers with thousand separators. 

 

The setting to apply the thousand separator is located in the setup screen in the Row and Column 

section, as shown in the image below. 

The new setting for applying thousand separators to numeric variables is highlighted in the image below. 

 

 

Note: Dot, Comma or Space can be used as thousand separators. You can make this selection in the 

Project settings page since it is a general project setting. 
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11 Data Field in Form: Setting for Thousand Separator 
A new setting has been added to the Data field in the Form to support thousand separators in numeric 

questions. The income field below shows the thousand separators. 

The setting is placed in the Content text panel, as shown in the image below. Note: The option only 

appears when a numeric question is selected. 

The image below shows the setting to be used for applying thousand separators to the Form. 

 

Note: Dot, Comma or Space can be used as thousand separators. You can make this selection in the 

Project settings page since it is a general project setting. 
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12 Answer Block Page Updates 
The Answer block page has been replaced with a new page since the old one page contained Silverlight 

controls which are no longer supported by all browsers. (Silverlight is still used in Data import related 

pages, but it will soon be removed from Dapresy Pro completely). 

The new Answer block page is shown in the image below. The changed and improved logic is described 

further down. 

The image below shows the new Answer block page. 

 

Search for questions: The search has been moved into the dropdown lists, rather being a separate 

control (see image below).   
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Search for answer options: A new search field has been added allows you to search for certain answer 

options in the selected Answer block. This is great to use when the Answer block has hundreds of 

answers. The search is conducted in the Text and the ID column. 

 

Select color template: The color template dropdown list now shows a preview of the first five colors. 

This makes it much easier to find and apply a certain Color template. A search option has also been 

added inside the dropdown list (see image below). 

 

 

Text field: The text field for entering/editing the answer text is now shown in multiple rows. This makes 

it easier to edit long texts because you can view all of the text at once. 
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 Sorting of answer options: You can sort answers in a few different ways: 

 Select one or more answers (click the most left column) and move them via drag and drop 

 Enter a sort order value in the Order column 

 Sort all answers alphabetically by clicking the Answer text column header 

 Sort all answers by ID by clicking the ID column header 

 Sort all answers by factor average  by clicking the factor average column header 

 

Note: Sorting via drag and drop cannot be made when the Answer option list has been filtered. Sorting 

by drag and drop can only be used when all answer options are shown in the list. 
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